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I. 
Introducing  
Autodesk  
Design Review

This chapter will introduce you  
to team collaboration utilizing  
Autodesk Design Review to  
streamline the process. 
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Whether involved in manufacturing, AEC, or geospatial industries, 
design is a collaborative process that involves those who need to review 
and comment on designs, but are not familiar with CAD software. 
Autodesk® Design Review software helps accelerate projects from 
start to finish with all-digital tools to review, mark up, and track 
changes to 2D and 3D designs without the original creation software. 
Team members can accurately measure, redline, and annotate drawings, 
maps, and models, and communicate changes in the context of the 
design. Add comments, track status, and drag and drop information 
of any type—CAD documents, project timelines, or raster images—
combining them into a single file. Then round-trip the DWF file to any 
Autodesk® design application, overlaying digital markups onto the 
original CAD file for fast revisions. 

Regardless of what industry you’re in, coordinating project reviews 
with Autodesk Design Review is easier, more efficient, and less costly 
than a paper-based system. Its benefits include:

•	 3D viewing, measure and markup capabilities

•	 Data security

•	 Instant transmission of data anywhere in the world

•	 Powerful markup and tracking capabilities

•	 Compact file size for e-mail and archiving

•	 Integrated workflow with Autodesk design software, to speed 
revisions and ensure no information is lost.

Only Autodesk Design Review lets you round-trip markups directly 
into Autodesk design software, including AutoCAD, Revit®, Autodesk® 
Inventor™, AutoCAD® Map 3D, and AutoCAD® Civil 3D®. Through 
an intuitive review and approval process project managers and 
CAD drafters can navigate from comment to comment across sheet 
sets and systematically walk through a review set to complete the 
approval process. The CAD user can see all changes marked by the 
Design Review user, and incorporate changes into the original CAD 
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application. The comment navigation feature of Autodesk 
Design Review ensures that all redlines and markups are listed and 
can be easily tracked throughout the design review process. The 
result: lower costs, better communication, and shorter cycle times. 
See how manufacturing, AEC, and geospatial customers are using 
Autodesk Design Review in their workflows.

Shortening Manufacturing Development Cycles

Autodesk Design Review software can help you get your products to 
market quicker by shortening development cycles. Utilizing Design 
Review software, you can receive feedback earlier in the design 
process and communicate outward to extended team members who 
don’t typically use computer-aided design (CAD) or 3D modeling 
software, such as customers, suppliers, and shop floor personnel. 

Design Review supports working in multiple formats, whether 
DWF™, DWG, DXF™, JT, or DGN—so team members see exactly what 
is intended. Easy-to-use tools allow the review, measure, mark up, 
and tracking of changes to 3D models or drawing sheet sets, while 
dramatically reducing review cycles, cutting costs, and improving 
team communication. 

With new support for securely sharing assembly instructions, bill of 
materials (BOM), and FEA results from Autodesk Inventor software, 
there’s an added array of publishing options that can improve the 
way you work. Plus with the tight integration with Autodesk Inventor 
and AutoCAD-based products, including AutoCAD Mechanical and 
AutoCAD Electrical software, you can systematically respond to 
comments and help ensure that revisions are timely and comprehensive. 
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See why DWF and Autodesk Design Review are the perfect partners 
for manufacturing: 

•	 Get Reviews Done on Time 
Connect customer, supplier, planner, and purchasing sooner and 
shorten the product development lifecycle with faster, more  
accurate design reviews. 

•	 Track Engineering Change Orders 
Autodesk Design Review automatically tracks comments and 
their status, helping to ensure that no information is lost.

•	 Accurately Communicate Design Information to  
the Entire Team 
Autodesk Design Review enables those unfamiliar with complex 
CAD software to fully visualize designs from Autodesk Inventor 
and AutoCAD-based applications. Manufacturing design data 
such as BOM information, assembly animations, finite element 
analysis (FEA) results, model representations, along with 2D and 
3D measurement, can all be accessed in Design Review.

•	 Protect Your Intellectual Property 
Protect your IP by sharing DWF files, providing complete accuracy 
and fidelity without sending the original CAD file. Password 
protection, encryption, and feature-disabling offer additional 
security.

•	 Integrated Autodesk PLM Solution 
Autodesk DWF technology and Design Review are fully integrated 
into Autodesk’s market-leading manufacturing design tools and 
PLM solution, including Autodesk® Productstream™, Autodesk 
Streamline®, and Autodesk® Vault®.
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Autodesk Design Review software streamlines your design review process 
with measure, markup and approval tools that help speed product develop-
ment to completion. Securely enable team members to accurately review 
2D and 3D designs digitally, offer feedback quickly and easily, and track and 
round-trip their changes while cutting days off the review cycle.

1   Product Design & Engineering
Gather customer, management, and 
product team feedback early. Review 
comments digitally in Autodesk 
Inventor, AutoCAD, AutoCAD 
Mechanical, and AutoCAD Electrical 
software, streamlining revisions. 
Autodesk DWF technology is built 
into Autodesk Productstream to help 
manage engineering design. 

2   Manufacturing Engineering
Improve communication with sup-
pliers and other departments by 
securely enabling digital reviews. 
Combine all project information like 
quotes, timelines, assembly informa-
tion in Autodesk Design Review 
software. For release management, 
Autodesk Productstream connects 
and integrates product data manage-
ment with the back-office systems. 

3   Manufacturing Production
Move to paperless production, 
securely sharing 3D models with 
manufacturing, suppliers, and 
partners. Model representations 
and configurations, animations and 
assembly instructions can be viewed, 
measured, and marked up with 
Autodesk Design Review. Addition-
ally, Autodesk Streamline provides 
collaborative project management.

4   Sales & Distribution
Accelerate marketing and sales abil-
ity to communicate with customers 
as soon as the product is released. 
Leverage the same 2D or 3D design 
data, post compact, secure DWF 
files on the Web, include within 
Microsoft® Office for sales materials 
or other communications. 

5   Maintenance & Repair
Make use of rich data sets to under-
stand maintenance and repair needs. 
Quickly understand design issues 
jumping from hyperlinks to product 
details, or interrogating the full 3D 
model and assembly instructions.

How Does Autodesk Design Review Speed Time to Market?
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Streamlining AEC Projects

Today, the architectural, engineering, and construction (AEC) process 
from design through construction, and later on into facility management, 
is more complex than ever. And the design review process is filled 
with team members who don’t typically use computer-aided design 
(CAD) software, such as clients, contractors, and consultants, yet who 
are vital to the project workflow. Autodesk Design Review helps you 
overcome these challenges by accelerating the design review process 
and putting the design in the hands of the people who need it. 

Easy-to-use tools help team members review, mark up, and track 
changes to sheet sets and building models, while dramatically  
reducing review cycles and costs and improving team communication. 
Tight integration with AutoCAD, AutoCAD® Architecture (formerly 
Architectural Desktop), AutoCAD® MEP (formerly Autodesk® Building  
Systems), Revit® Building, Revit® Structure,  Revit® MEP, and AutoCAD® 
Civil 3D®provides a systematic method to respond to comments and 
help ensure that revisions are timely and comprehensive. 
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Here are some of the ways that Autodesk Design Review takes 
advantage of existing investments in established workflows to help 
building firms gain that elusive competitive advantage:

•	 Accelerate Review Cycles 
Cut two to three days per review cycle by using Autodesk Design 
Review software with Revit and AutoCAD-based products to 
electronically review, mark up, and revise designs.

•	 Use Digital Back Checks 
Reduce errors that cost time and money and affect your reputation 
by using Design Review for back checking. Enable team members 
to automatically track and review changes and their status with-
out waiting for printouts.

•	 Visualize Designs for Client Presentations 
Autodesk Design Review enables team members unfamiliar with 
complex CAD software to fully visualize drawings and models,  
including tools to rotate and cross-section models without alter-
ing the original file. Include interactive drawings and models in 
Microsoft® PowerPoint® slide sets for more effective presentations.

•	 Document Construction Change Orders 
Use the markup and status tracking tools in Autodesk Design Review 
to track changes required throughout the construction process.

•	 Reduce Printing and Shipping Costs  
Save as much as $100 per job while enabling team members to 
fully participate in a digital design review process. Going digital 
means no more waiting for drawings to be printed and distributed 
and then faxed back to the designer.
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Autodesk Design Review software streamlines your design review process 
with custom markup and approval tools that help speed the project to 
completion. Now team members can accurately review 2D and 3D designs 
digitally, offer feedback quickly and easily, and track and round-trip their 
changes while cutting days off the review cycle.

1   Preliminary Design
Speed designs to approval and 
improve communication utilizing 
Autodesk Design Review software’s 
intuitive digital review, measure and 
markup tools for 2D and 3D designs. 
Gather client and management  
feedback early. Review comments 
digitally Revit-based products,  
AutoCAD Architecture, and  
AutoCAD MEP software, stream- 
lining revisions. 

2   Consultant Collaboration
Improve collaboration with Struc-
tural, MEP, Landscape and other 
engineers and cut review cycles 
by up to 2-3 days using Autodesk 
Design Review software for internal 
and external reviews.

3   Construction Validation
Gain insight early in the process, 
securely sending designs to GC for 
“constructability” reviews. Combine  
all project information such as con-
struction cost estimates and project 
timelines in Design Review software. 
Additionally, Autodesk® Collaborative 
Project Management, with DWF 
technology built in, helps expedite 
processes with bidding and project 
management tools.

4   Building Permitting
Digitally automate the permitting 
processes with city planning depart-
ments or government agencies  
accepting DWF-based plans, review-
ing them digitally, and communicating 
changes quickly. The result is faster 
permit granting processes, reduced 
paperwork, and improved data 
archiving.

5   Construction
Enable on-site markups and easy 
tracking and communication of 
construction changes back to the 
lead architect digitally. Speed access 
to any needed paper-based plans 
thanks to DWF technology integra-
tion with large-format printers. Once 
construction is completed, building 
inspections move quickly and can be 
signed-off digitally by government 
agencies using Design Review’s 
markup and approval tools. 

6   Facilities Management
Provide access to building plans and 
enable facility managers to commu-
nicate any asset updates or changes 
to building owner digitally. Design 
plans can be easily shared across an 
Intranet for easy access.

 

How Does Autodesk Design Review Streamline AEC Projects?
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How Does Autodesk Design Review Streamline AEC Projects?
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Keep Geospatial Data Up to Date

Ensure that you have the most up-to-date, accurate drawings, maps, 
and models in the office or out in the field, at all times. As teams extend 
and field forces increase, an easy-to-use electronic distribution system 
is crucial for distributing designs. But productivity is a two-way 
street. You also need to capture change requests, update the data, 
and then electronically send it back. 

Utilizing DWF technology and Autodesk Design Review software, 
you can communicate digitally and receive feedback from extended 
team members who don’t typically use computer-aided design (CAD) 
software, such as construction crews, field staff, or planners. Among 
other formats, Design Review supports standards for design, DWF 
and DWG, assuring team members see exactly what is intended. 
Easy-to-use tools allow the review, mark up, and tracking of changes 
to drawings, maps, and 3D models, while dramatically reducing 
review cycles, cutting costs, and improving team communication. 

Team members can communicate changes in context, including 
object properties, geo-location, asset utilization, and job tickets. 
Add comments, track status, and drag information of any type—site 
photos, project timelines, or standards documents—combining them 
into a single file. Plus with the tight integration with AutoCAD®, and 
AutoCAD® Map® 3D, and Autodesk® MapGuide® you can systemati-
cally respond to comments and help ensure that revisions are timely 
and comprehensive. 
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See why Autodesk Design Review is the perfect partner for your teams:

•	 Automate Information in the Field 
Get the most from your existing investment in Autodesk MapGuide, 
AutoCAD Map 3D, AutoCAD Raster Design, or AutoCAD software 
by quickly distributing compact, highly accurate geospatial and 
system information to team members in the field. Field staff can 
easily review and mark up the files in Design Review and send 
them back to the designer. Field workers with GPS-enabled laptops 
can view and interact with assets on maps and identify their own 
current location and the locations of specific assets.

•	 Distribute Compact Files  
Share complex maps easily with DWF technology, typically 1/20 
the size of a DWG file and 1/10 the size of a PDF file.  

•	 Reduce Paper Backlogs to Keep Mapping  
Information Up-to-Date  
Use Autodesk Design Review software with AutoCAD Map 3D, 
Autodesk MapGuide, and AutoCAD software to reduce paper 
backlogs by getting changes made in Design Review back from 
the field electronically. 

•	 Document Construction Change Orders 
Bring changes noted in Autodesk Design Review back into the 
original design. No longer do you need to create as-built plans 
from scratch—simply update the as-designed plans with markups 
from Design Review software.
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Autodesk Design Review software streamlines design review processes with 
custom markup and approval tools that help ensure everyone has the most 
up-to-date drawings, maps or models. Now team members in the office or out 
in the field can accurately review 2D and 3D designs digitally, offer feedback 
quickly and easily, and track and round-trip their changes while cutting significant 
time off the review cycle.

Autodesk Design Review allows you to leverage existing technology invest-
ments in Autodesk design software and third-party systems such as geospatial 
data storage, work management, or ERP to automate processes.

1   Drafting & Design
Speed processes utilizing Autodesk 
Design Review to digitally share and 
review geospatial data within your 
organization or with external consul-
tants. Review and integrate changes 
digitally in AutoCAD Map 3D, and 
AutoCAD software, streamlining 
revisions.

2   Construction
Reduce rework and paper-based 
backlogs. Automatically track  
construction change orders in 
Design Review, allowing reuse of  
as-designed plans for as-built plans.

3   Maintenance & Operations
Regularly deliver field staff up-to-
date, highly accurate geospatial 
and system information that can be 
viewed in Autodesk Design Review. 
Redlines and annotations performed 
during inspection or service calls 
can be retrieved from the field and 
routed for updates.

4   Planning & Analysis
Flexible technology integrates into 
existing systems. Increased accuracy 
of infrastructure data improves 
planning and analysis, and ultimately 
service levels.

 

 How Does Autodesk Design Review Streamline Geospatial Projects?
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 How Does Autodesk Design Review Streamline Geospatial Projects?



II.   
Getting Started  
with Autodesk  
Design Review

This chapter provides instructions  
on installing and using your  
Autodesk Design Review software.
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Before You Install

System Requirements

Before installing the Autodesk Design Review ensure that your 
system meets the following requirements for each component of the 
software installation:

•	 800 MHz 32-bit (x86) or 64-bit (x64) processor or faster

•	 Microsoft® Windows® Vista, XP Professional or Home Edition, or 
Windows 2000 (SP4) 

•	 512 MB RAM recommended (for Windows Vista users, 1 GB RAM 
or more recommended) 

•	 550 MB free disk space for installation 

•	 1024x768 VGA with true color (minimum) 

•	 Microsoft Internet Explorer 6 or later

•	 Mouse, trackball, or compatible pointing device 

•	 CD-ROM drive, DVD-ROM drive for 64-bit systems installing 
from CD

•	 Optional Hardware:

•	 3Dconnexion SpaceTraveler™ support for 2D and 3D navigation 

•	 GPS device set to communicate using NMEA 0183 standards, 
the standard 4800 baud rate, and a COM Port (COM1 to 
COM10). This includes: GPS device bundled with Microsoft 
Streets and Trips 2006, Panasonic Toughbook® with integrated 
GPS device, USB connected GPS device, Bluetooth connected 
GPS device set to use a COM port
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To Install the Software when Downloaded from the Autodesk  
Website

1. Visit www.autodesk.com/designreview-download, and select to 
download Autodesk Design Review software.

2. Save the application to your computer.

3. Double click the Autodesk Design Review application icon. 

4. Follow the installation instructions.

To Install the Software from a CD

1. Close all open applications.

2. Insert the CD into the CD-ROM drive.  If the setup program does 
not start automatically, go to step 3.

3. Choose Run from the Start menu.

4. Type d:\setup (where d is the CD-ROM drive).

5. Press Enter.

6. Select the products you want and then click Install.

To Deploy Autodesk Design Review Across a Network

Autodesk Design Review can be installed silently via the following:

msiexec /i SetupDesignReview.msi /qn

By installing Autodesk Design Review silently, the viewer can be 
included as part of a company-wide automated script. For example, 
this is particularly useful when installing software company-wide 
using SMS.

Companion Products to Install

When you install Autodesk Design Review 2008, there are several  
additional software components you may want to install on your system:
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Through the File>Import command, Autodesk allows you to bring in 
different CAD file types. Design Review calls a command to publish 
the file to a DWF for easy integration into your sheet set. It is recom-
mended that you install the following plug-ins if you work with the 
respective file formats:

•	 DWG TrueView™ 
To view, plot, and publish DWG® and DXF™ files.

•	 Autodesk® DWF Writer™  
To create DWF files from any Windows application, including  
Microsoft Office applications, or to utilize the DWF Writer plug-ins 
for Solidworks, Pro/ENGINEER, and CATIA.

•	 JT Plug-in for Autodesk Design Review  
To import and publish JT files, a common UGS format, to DWF.

•	 DGN Plug-in for Autodesk Design Review 
To import and publish DGN files, a common MicroStation format,  
to DWF.

Additionally, the Batch Print Plug-in with HP Instant Printing helps 
increase productivity by automating the printing capabilities with the 
power of sending multiple DWF files at once to your printer. Simplify 
the printing process further when connected to an HP large-format 
printer, instantly printing from Autodesk Design Review single sheets 
or batches of DWF files.

You can download the plug-ins from the Autodesk website at  
www.autodesk.com/dwf-plugins  

How to Register Your Software

Be sure to register your product over the web by completing the 
registration form at www.autodesk.com/designreview-download. 
By registering, you‘ll stay informed about product updates and special 
product offers from Autodesk.
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Training and Support

Autodesk and its partners provide extensive training and support offerings.

To Get Online Help

Within Autodesk Design Review, choose Help from drop-down menu 
to access a rich library of information about the product.

Support Resources on the Web

Visit www.autodesk.com/designreview-support and find a  
knowledge base of commonly asked support questions as well as  
current issues. Also, you can ask questions and read information 
about the use of Autodesk products in the peer-to-peer discussion 
groups on www.autodesk.com/designreview-discussion; Autodesk 
hosts topical discussion groups about specific products, including 
Design Review, and general topics, such as drafting techniques and 
sharing designs with the DWF file format. Alternatively, Autodesk 
software manuals and documentation are a great source of answers 
to your support questions.

Training Resources on the Web

Visit www.autodesk.com/designreview-training for a complete list 
of training resources.

Autodesk Authorized Training Centers

The Autodesk Authorized Training Center (ATC®) network, Autodesk’s 
premier training channel, offers short, industry-focused courses for 
beginning and advanced users. To find a training center near you, 
contact your local Autodesk country office or visit  
www.autodesk.com/designreview-atc.

A complete list of support options is available at  
www.autodesk.com/designreview-support.



III. 
New Users to  
Autodesk  
Design Review

The following pages provide a  
tutorial overview on the basics  
of using Autodesk Design  
Review software. 
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The following pages provide a tutorial overview on the basics of using 
Autodesk Design Review software. The tutorial includes information 
on how to open a DWF file, navigate, measure, markup, annotate, 
change the status, and round-trip the designs to the designer for fast 
revisions. There is also a section on using Design Review for 3D  
reviews, along with information about our new version compare, 
online content search, and geo-referencing features. 

Detailed product information is available in the product Help menu. 
To activate the product Help, select Help from the main menu.

The Workflow: Send, Review, Markup, Round-trip, Revise

Below is an overview of the design collaboration process between 
the “designer” using Autodesk software and the “reviewer” using 
Autodesk Design Review software. 

For the purposes of this tutorial we will walk through the process 
with a sheet set from AutoCAD and a 3D model from Autodesk In-
ventor, but the same processes hold for working with any of the other 
Autodesk design software. Autodesk Design Review also supports 
review and markup of 3D DWF files published from any Autodesk 
design software or from any third-party design software with  
the free Autodesk® DWF™ Writer, available at  
www.autodesk.com/dwfwriter. 
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diagram: xplane®
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Step 1: Open the Sheet Set and Review its Contents

You can review the contents of a sheet set or model by navigating to 
any sheet in a list or thumbnail view.

1. 	 Double click on the Autodesk Design Review application icon  
on your desktop or navigate from your Start menu.

	 Open the DWF file you want to work with by using the file  
open icon  or File/Open command and navigating to the  
sample file provided.

	 For the purposes of this tutorial we’ll walk through the manufac-
turing project, but the same steps can be followed with an AEC or 
geospatial project.

2. 	 If you have received a DWG, DXF, JT, or DGN file, rather than a 
DWF file, use the File/Import feature to automatically convert the 
DWG file to a DWF file for review. (Note: You may need to install 
additional plug-ins to utilize this feature.)

3. 	 When the DWF file opens, you will see the Navigator window 
displaying the sheets and models in the DWF file. The first sheet 
is automatically displayed. (Figure 1.1)

4. 	 Select the 6th item in the Content palette, titled “Drawing - 
Shaver Complete - Sheet:2”

Step 2: Zoom in

Zoom in to a section where you’ll take a measurement and create a 
markup. The next person to open the markup will see it at the zoom 
in which you create it.

1.	 Select the Zoom Rectangle button   from the main toolbar. 
(Figure 2.1)

2.	 Drag it across the shaver in the right corner of the drawing,  
allowing some extra space on the right for markup. The area will 
highlight. (Figure 2.2)
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Reviewing Contents of a Sheet Set

 
Navigator/Content 
palette displaying 
sheets and models

Figure 2.2 The Zoom 
Rectangle tool will 
zoom into the high-
lighted area.

Figure 1.1

Figure 2.1 
Select from  
the Zoom drop 
down menu.
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3.	 Use the Pan button    to move within the sheet and reposition 
your view.

•	 The Zoom button    allows you to zoom in or out of the 
sheet or model.

•	 The Fit to Window button  allows you to refit the sheet or 
model within the window, returning it to its original position.

•	 Use the “Esc” key to release the tool you are using.

Step 3: Print Sheets or Models

Autodesk Design Review provides flexible printing options, allowing 
reviewers to print to standard or large format printers with the same 
quality experienced from the original design software.

1.	 From the main menu, select File and then select Print, or  
select the Print button  from the main toolbar. The Print dialog 
box opens. 

•	 To navigate the sheets, in the Print Range section click All. 
Then click the Left and Right Arrows below the preview area. 
(Figure 3.1)  

Print Sheets or Models

 
Figure 3.2  > 
Choose your preferred 
print settings including 
print in black & white, 
then select OK.

 
Figure 3.1 
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2.	 Select from the following print options: Printer, Paper, Print 
Range, Page Handling, Scaling and Alignment, Orientation, and 
Color Setting. 

	 These settings affect the preview display as well as the output.

3.	 Click OK once you are satisfied with your selections. (Figure 3.2)

4.	 Select File > Batch Print Wizard… to print multiple DWF files, 
customize print settings, and save batch printing configuration 
for later use.

•	 Navigate your directory to locate the DWF files you want to print

•	 Create and save custom lists for future use.

Note: If you have not installed the Batch Print Plug-in for Design Review 
you will be prompted to do so before this feature is available.

5.	 If your computer is connected to an HP printer with Instant 
Printing capabilities, you can take advantage of a partnership 
Autodesk has with HP to provide a one-click method of printing 
called HP Instant Printing™ (HPIP) from the standard or batch 
print options.

	 To activate this option select the Instant Printing button  from 
your main toolbar. The button will automatically appear if you 
have an HP printer that supports this functionality installed on 
your system. For a list of printers that have HP Instant printing 
capabilities, see the HP Instant Printing Web site at  
http://www.hp.com/go/hp-instant-printing.

Step 4: Measure

DWF files are smart. They contain information about the drawing in 
the background. For example, you can find out the dimensions of an 
object without needing to calibrate the dimensions of the drawing.

1.	 Click on the measure button   in the main toolbar. (If the 
length tool is not displayed as in the illustration, click on the 
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downward pointing arrow of the measure tool button and select 
it from the expanded list.) (Figure 4.1)

2.	 Hover the cursor over the switch until you see the red snap point 
with the white center . 

3.	 Click and drag until you see the same snap point on the other side 
of the switch. A measurement should appear between the two 
end points. (Figure 4.2)

4.	 You can change the units display of the measurement by  
selecting, Tools > Units and Scale. The measurement above for 
example can be changed to centimeters or inches for example.

5.	 Once you’ve noted the measurement of the switch, select the 
measurement with the Select Objects tool and hit your  
“Delete” key. You can delete any measurement or markup 
throughout your review in this way.

 Step 5: Mark Up a Drawing Sheet

The Autodesk Design Review markup tools include revision clouds, 
text, shapes, and stamps allowing reviewers to comment on the 2D 
and 3D designs.

1.	 To create a revision cloud, click on the Markup tool . If the 
rectangular markup cloud is not displayed, click on the down-
ward pointing arrow of the Markup tools and select it from the 
expanded list. (Figure 5.1)

2.	 To create a revision cloud, click and drag the cursor diagonally 
across switch, release the mouse, and click again where you want 
to place the text tag. If you chose to markup with a unique shape, 
you will want to click at each corner on the shape.

3.	 Type the text: “Adjust switch terminal to extend on position by 
.10mm” and click outside the markup or hit “Esc” to finish.  
(Figure 5.2)
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Measuring and Marking up a Drawing Set

 
Figure 5.1  Select from  
pre-defined markups.

 
Figure 5.2  A rectangular target cloud with 
a markup comment.

 
Figure 4.2  Select the line length tool. Then 
click, drag, and release from end point to end 
point.

 
Figure 4.1  Select from 
three measure tools.
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Step 6: Change the Status of the Drawing

You can change the status of a drawing and write additional notes to 
others. All markups along with their status and notes are automatically 
tracked in Autodesk Design Review throughout the revision process.

1.	 With the Select Objects tool click on the markup you just 
made. The markup will display yellow grips for the corners.  
(Figure 6.1)

2.	 In the Navigator Markup palette the markup will display along 
with a status of “none.”

	 You can also add a note in the Notes section if you want. 

	 Within the Properties palette, in the Status drop-down box,  
click on the downward pointing arrow and select For Review. 
(Figure 6.2)

	 The markup palette and icon will change colors to visibly display 
the markup status for a quick visual check. (Figure 6.3)
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Changing the Status of a Drawing

 
Figure 6.1  Markup displaying 
yellow grips when selected.

 
Figure 6.3  For visual reference, markup display 
color cross-selects with status change.

 
Figure 6.2  Status drop-down 
menu displayed.
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Step 7: Stamp the Drawing and Add Objects

You can stamp a drawing with a status at any point along the way or 
add objects importing from virtually any catalog. 

Design Review has seven preconfigured stamps. Once you stamp 
a drawing, you can change the text and appearance of the stamp. 
(Figure 7.1)

1.	 To stamp a drawing, click on the downward pointing arrow of the 
Create Stamp and Symbols tool  and select a stamp from the 
drop-down list.

2.	 Click where you want the lower, left corner of the stamp to  
appear. (Figures 7.2)

3.	 Change the text in the Stamp, by using the Select Objects tool  
to select the Stamp. Double click to engage the text box. Change 
the text from “Preliminary” to “Draft 1”. (Figures 7.3)

4.	 After selecting any Markup, Stamp, or Symbol you can rotate or 
resize it by grabbing and moving the object.

5.	 To import a symbol or object library, Click on the Stamps and 
Symbols button and select Import DWF as Symbol Catalog. 
Browse and find the DWF file you want to import. 

	 Any DWF file can be imported including AutoCAD object libraries 
published to DWF or other graphics files published using the  
Autodesk DWF Writer. Once imported, the symbols or objects  
act just like the Stamps. 
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Figure 7.1  Use one of 
the stamps as-is, or 
change it to suit your 
needs.

Stamping the Drawing and Adding Objects

Figure 7.2  The default 
appearance of a stamp.

Figure 7.3  Stamp with 
text changed.
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Step 8: Combine Project Information

Autodesk Design Review allows you to aggregate project information 
into a single DWF file. 2D and 3D designs can be combined into one 
file. Timelines, images, bill of material data and much more can be 
combined. You can also reorder, name, or delete project information 
at any time.

1.	 Open your Windows Explorer menu and find any Raster image or 
DWF file to drag and drop into the Navigator/Content palette. A 
vertical line on the left indicates where the sheets will be placed 
in the Thumbnail tab. (Figure 8.1)

	 You can now open any of the added sheets just like any other 
sheet in the DWF, by clicking on it. When you save the file, the 
added sheets will be incorporated into the DWF file, and anyone 
opening it in Autodesk Design Review.

	 If you have an Excel, Word, or other file type you would like to 
drag into the file, use Autodesk DWF Writer to publish the file 
to DWF. You can then drag the DWF file into the Design Review 
Navigator/Content palette.

2.	 To capture and bring any onscreen information into your DWF 
file, select the Snapshot tool  on your main toolbar. 

	 A new Snapshot window will appear. (Figure 8.2) 

•	 Select the onscreen window where you want to  
capture information.

•	 Resize the Snapshot window.

•	 Click on the Snapshot icon in the lower left.

The image will appear at the end of your list of sheets and models.

3.	 Move the new sheet to any new position in the Navigator/Content 
list by simply dragging and moving it to its desired position.  
(Figure 8.3)

4.	 Rename the file by double clicking the name and typing a new name.  
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Figure 8.1  Drag and drop any DWF or Raster File 
directly into the Navigator/Content palette.

Combining Project Information

 
Figure 8.2  Capture and add any 
onscreen information with the 
Snapshot tool.

 
Figure 8.3  The Snapshot tool 
will add captured information to 
the Navigator/Content palette.
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Step 9: Save the Sheet Set with Markups

Save the sheet set with your markups and the added sheets. You 
can then share it with other reviewers or send it back to the designer 
for revisions.

1.	 From the main menu, select File and then select Save As….  
(Figure 9.1)

2.	 In the File Name window, highlight the current name, except for 
the .dwf extension.

3.	 Type in a new name, such as “YourNameMarkup.” (Figure 9.2)

4.	 Click the Save button.

5.	 Click the Close button  at the top, right of Design Review to 
close the software.

The drawing is ready to be sent back to the designer or on to  
another reviewer.

 
Figure 9.1

Save the Sheet Set with Markups

 
Figure 9.2
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Step 10: Back to the Designer:  
The Designer Revises the Drawing Sheets

Once you have saved the sheet set, you can send it back to the  
designer or on to others until all comments and changes are noted 
and communicated throughout the review process.

If the individuals to whom you send the marked DWF have Autodesk 
design software they can open the DWF file with markups directly 
using the Markup Set Manager feature in their design software. They 
can add notes and change the status of the sheet just as you can. 

To access the Markup Set Manager feature, in AutoCAD select the 
red cloud button on the main toolbar, or File and then select Markup 
Set Manager. (Figure 10.1)

The Designer Revises the Drawing Sheets

 
Figure 10.1  Display of Markup Set Manager feature 
in Autodesk Inventor.
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The Markup Set Manager feature in Autodesk design applications has 
the same markup navigation view as that in Design Review, allowing the 
designer to systematically walk through and make revisions easily. The 
designer can also toggle on/off the markup layer to see what changes are 
requested, and make the changes in Autodesk design software.

If the designer does not use Autodesk design software, or is using 
an earlier version of Autodesk design software that does not have 
the Markup Set Manager feature, they can view your markups in 
Autodesk Design Review.

You can exchange the DWF indefinitely until all issues are resolved 
and the original drawing is revised.
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IV. 
Advanced Features in  
Autodesk Design Review

The following pages provide an  
overview on the new and more  
advanced features in Autodesk  
Design Review software.
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Working with 3D DWF Files

Autodesk Design Review is built for review of sheet sets and 3D 
models in a single file. Reviewers can aggregate 2D and 3D files in 
a single DWF file as demonstrated in Step 8 of this tutorial, or the 
designer can publish both 2D and 3D together in a single DWF file for 
sharing. (Figure A)

1.	 The 3D toolbar is different, allowing you to navigate different 3D 
views. 

To rotate the view of the model:

•	 On the main toolbar, use the Orbit button  to drag and 
rotate the model within the model itself. To rotate the object 
horizontally, vertically, or diagonally, click and drag the mouse 
pointer. Press and hold the Shift key and drag horizontally to 
prevent vertical movement. Press and hold the Ctrl key and 
drag vertically to prevent horizontal movement. Note: If you’re 
working with a building model use the Turntable tool  .

•	 Select a pre-defined view from the Standard Views button . 
(Figure B) 

•	 Navigate from the Navigator/Model palette and select from 
within the tree view a particular part or assembly. The selection 
will be highlighted in the model window.

•	 Navigate from the Navigator/Views palette to a predefined 
view or one you add yourself.

•	 To Save a View, select the Views palette toolbar, click the 
Palette Options button  and choose, “Save View”. The view 
will be added to your “My Views” selections. You can also use 
this same tool to Reset to Published View. (Figure C)

•	 Use the View Object Wheel tool  to access many of these  
navigational capabilities from within one tool including Center, 
Orbit, Zoom, and Rewind. If you’re working with a building 
model or want full access to the navigational features you’ll want 
to use the Tour Building Wheel or Full Navigation Wheel 
mode, respectively.
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•	 The View Cube also allows you to navigate to pre-defined 
views—whether Front, Back, Left, Right, Top, or Bottom.

Working with 3D DWF Files

 
Figure A This DWF  
files has both sheets and 
models in one space.

 
Figure B  Toolbar, showing 
pre-defined 3D navigation 
in Autodesk Design Review.

 
Figure C  Reset to Published View from the Views palette.
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2. 	 To more fully interrogate the model, you’ll want to pull apart and 
cross section the model.

•	 To pull apart, select the Move and Rotate button  , and 
then in the Model palette or on the canvas, click the object or 
objects that you would like to move or rotate. You can move 
the object along the corresponding plane.

•	 To cross section the model, select the Cross Section button   
and select a section plane. 

•	 A transparent purple sheet (the section plane) and a tripod 
drop into the center of the model, cutting through the model 
to reveal a cross section. The section plane can be moved or 
rotated to reveal a different cross section each time. XY, YZ, 
and XZ each represent a plane defined by two of the three 
axes of the tripod that opens. 

3.	 DWF files may be published with or without Animations, Assembly 
Instructions, or table data, such as parts lists or bills of materials. 
When a DWF file is published, the author can include any of this 
information to share with the product team. 

•	 Animations allow reviewers to users to observe the details of 
assembly and/or component objects more closely and see how  
and in what order they fit together. The Animations palette lists 
the animation views, chapters, and sequences in an expanded 
tree view. The animations can be viewed by selecting the 
sequence and by using the animation tools, in the main toolbar 
to control the sequence. The same set of tools—measure, 
markup, annotate, and snapshot can all be used with the 
animation sequences to help coordinate design reviews.  
(Figures D & E)

•	 Assembly Instructions are attached to individual sequences 
in an animation by the designer. They explain, step by step, 
how to create the currently loaded assembly. They can include 
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Animations and Assembly Instructions

 
Figure D Animation palette 
in the Navigator window.

 
Figure F  Bill of Materials information displayed in the 
Canvas pane.

 
Figure E  Animation toolbar used to control the playback 
of Autodesk Inventor animations.
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text instructions and parts lists and are meant for use in a 
manufacturing setting to provide clear and concise instructions 
in conjunction with Design Review’s View Animations feature. 

•	 Design Review allows you to view Bill of Materials or other 
Tabular Data, in a published table, about individual parts that 
combine to create a component assembly or sub-assembly. 

•	 Use the Arrange Display Areas tool  to select your chosen 
layout to view the information shared by the designer.

•	 The Canvas Pane in the lower right section of the Design 
Review window displays assembly instructions and bill of 
materials information. (Figure F) 

4.	 You can Measure 3D DWF files just as you measured DWF files in 
Step 4 of the tutorial. In 3D, you can measure:

•	 Length and relative distances between points, edges, center 
points, or any combination of these 

•	 Angles between lines, planes, and edges. 

•	 Length, radius of an arc, or the diameter or radius of a circle

•	 Point location relative to currently active coordinate system, 
or to a user-defined coordinate system.

	 The units of measurement can be Imperial (feet and inches) or 
metric, and they can be up to five decimal places in precision, 
depending on the precision set by the author of the DWF.  
(Figure G)



Autodesk Design Review Getting Started Guide 43

5.	 Markups and Annotations are made just as performed earlier 
in Steps 5 and 6 of the tutorial. New to Autodesk Design Review 
2008 is the support for persistent 3D markups.

	 To mark up the 3D DWF file:

•	 Click the Markup tool  

•	 Click on the model where you want the markup to appear

•	 Type in your desired markup.

	 When you move, orbit, or rotate the model, the markups will 
remain in position. (Figure H)

 
Figure G   
3D measure tools provides 
an expanded set of options.

Measurement, Markups and Annotations

 
Figure H >   
Markup on 3D model in 
Autodesk Design Review. 
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Drawing Version Compare

Design Review can compare 2D DWF files and vector content to allow 
a reviewer to understand what has changed between versions. 

1.	 From the main menu, select Tools and then select Compare. 
The Compare dialog box opens. (Figure J)

2.	 Select the Browse button, locate the DWF file you would like 
to compare, and click Open. A full list of the sheets in that file 
will appear.

3.	 Select the sheet you want to compare.

4.	 Click on Options to choose what color is used to define  
additions or deletions to the drawing between the versions.  

5.	 Select OK. A visual comparison will be displayed in the content 
palette, along with a list of the additions and deletions between 
the versions in the Navigator/Markup palette. 

	 Warning: Occasionally, comparing DWF files may produce some 
unexpected results. Design Review will identify all differences  
between two DWF files, whether the difference is made intentionally 
by a reviewer or unintentionally by an anomaly in a publishing 
program. It will be unable to compare both vector (shapes) and 
raster (pixels) content—a common publishing error that occurs 
when a 2D DWF file is published from a 3D model space. 

Online Content Search

Design Review 2008 enables you to search online for a selected 
part’s description, title, or part number. 

To search online for information not in the open DWF file:

1.	 Choose Tools > Search Online, or select the Search Online 
button from the main toolbar  . The search engine dialog is 
opened in a separate window. (Figure K)
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2.	 In the “Search Online For” text box, type the desired search term 
or terms. (Warning: Double-byte characters are not supported.)

3.	 Click Search. Search results for the typed search terms are 
returned in the same window by the default search engine. 

4.	 You can view search results from other search providers by 
clicking the other tab(s) on the Search page. 

You can also search online for information on an object selected on 
the canvas, for selected properties, or for selected tabular data like a 
part number, by right clicking that data and selecting “Search Online…” 
Search results for the selected property value(s) are returned in a 
separate window by the default search engine.

Compare and Online Search 

 
Figure J   
Compare dialog box. 

 
Figure K   
Search Online is especially  
useful for procurement agents 
and purchasing specialists.
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Georeferenced Maps

In Design Review 2008, sheets with defined latitude and longitude 
coordinates published from AutoCAD® Map 3D 2008 or AutoCAD® 
Civil 3D® 2008 can interact with GPS devices that use the NMEA  
0183 protocol. 

When a georeferenced map is displayed on the canvas, the Map  
Toolbar is displayed directly below the canvas.

1.	 To view published map coordinates, move the mouse pointer 
over the map. The current coordinates of the mouse pointer 
are shown on the Map Toolbar. (Figure L)

2.	 To center on coordinates, on the Map Toolbar, click the Center 
to Coordinates button  and click on the map. The map cen-
ters on the entered coordinates, and the Coordinate icon is 
shown over the entered coordinates. You can also select the 
Map Menu button  and choose Enter Coordinates, then 
type or copy and paste the desired coordinates.

3.	 To identify your current location, you must also be connected 
to a GPS Device. 

•	 Configure you GPS device by choosing Tools > Options, and 
selecting the GPS tab. Then walk through the setup steps. 

•	 On the Map Toolbar, click the GPS Mode button . The My 
Coordinates icon indicates your current location on the 
georeferenced map.

Georeferenced Maps

 
Figure L The Map toolbar displays the latitude and longitude.
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Integrated with Microsoft Applications

Working with Autodesk Design Review and the DWF format also  
enables collaboration within familiar Microsoft® environments.

1.	 To embed in Microsoft Office applications, drag designs into 
Microsoft® PowerPoint®, Word, or Excel® programs and allow 
others to visualize designs in presentations and more. (Figure M)

2.	 Search in Microsoft Explorer to find relevant data using any 
text in the targeted DWF file. (Figure N)

3.	 To post DWF files on the Web embed Autodesk Design Review 
or the free Autodesk DWF Viewer in HTML utilizing the Design 
Review API and Active-X control. Information is available at 
www.autodesk.com/dwf-developers. (Figure P)

Integrated with Microsoft Applications

 
Figure M  

 
Figure N  

 
Figure P  
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You Could Get Used to This

The design is just the first step. It’s what happens next that can make 
or break the project. Autodesk Design Review is the tool that helps you 
make your vision a reality in less time, and with less cost and effort. 
Never has your design review process been this efficient. Never has 
an idea been realized like this.

Learn More or Download 
To learn more about Autodesk Design Review software, visit 
www.autodesk.com/designreview

To download Design Review go to 
www.autodesk.com/designreview-download 
Information on DWF™ is available at www.autodesk.com/dwf 
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